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Chapter 3

UCS, Viewports and Wireframe Modeling

,Jg

OhjeCtiVe'S

¢ Understand the Use of UCS on More
Complex Designs

¢ Display and Orient 3D Views

¢ Apply and Expand the Basic Wireframe
Construction Techniques

¢ Use Additional Tools to Assist the
Creation of 3D Wireframe Models

¢ Use the Named Views Option




3-2 AutoCAD 2021 Tutorial: 3D Modeling

Introduction

In the previous chapter, we examined some of the basic techniques to create 3D
wireframe models. Again, a wireframe model is a skeletal description of a 3D object.
There are no surfaces in a wireframe model; it consists only of points, lines, and curves
that describe the edges of the object.

In this chapter, we will further discuss the techniques and wireframe modeling tools
available in AutoCAD. Instead of creating the corners and edges of wireframe models by
entering the precise 3D coordinates, the use of construction lines and referencing
techniques are illustrated. The construction of edges in 3D space can be simplified by
using the AutoCAD User Coordinate System. We will also use the multiple viewports
option, which is available in most CAD systems, to aid the construction of 3D wireframe
models.

It is important to point out that most of the construction tools used in creating 2D designs,

such as Object Snap and Polar Tracking, as well as the Copy, Mirror, and Array
commands, are also applicable to the constructions of 3D wireframe models.

The V-Block Design




UCS, Viewports and Wireframe Modeling 3-3
Starting Up AutoCAD 2021
1. Select the AutoCAD 2021 option on the Program menu or select the AutoCAD
2021 icon on the Desktop.
l Athentech Imaging
. AutoCAD 2021 - English
ﬁ Attach Digital Signatures
AutoCAD 2021 - English
/ L3
m Batch Standards Checker
- Reference Manager
L [Type here to search
2. In the Startup window, select Start from Scratch.
3. In the Default Settings section, pick Imperial (feet and inches) as the drawing
units.
[ 4. Pick OK in the Startup dialog box to accept the selected settings.
3D Modeling Workspace
{553D Basics -5
Drafting & Annotation odify| 1. Click on the workspaces list in the Quick Access
: toolbar and choose to use the 3D Modeling
3D Basics
. workspace as shown.
3D Modelingh (A
' 2. On your own, switch on the Menu Bar.
| Save Current 3D Modeling y
Workspace 3 Press F1 for more help || > Notice the different 3D modeling toolbars
Customize.. I available in the Ribbon toolbar area as shown.
A O HEHE L 2 &<~ o« £530Modeling -5 Drawing1.dwg ¥ | Type a keyword or phrase O, & Rshih e A (- - OX

Home  Solid Surface Mesh Visualize Parametric Insert Annotate View Manage Output Collaborate -

~ e & M - .tttz 13 .
Box  Extrude s Smooth ¢ =] g v D‘_- l Section ,’ o T> t y Unsaved View
" " obet @ & SW-O0O- 4 AR E8 - pane 2. 18 World v [of -

Modeling + Mesh 3 Solid Editing Draw » Modify + Section » ¥ Coordinates ¥ View » Selection v -

lling| NoFilter ~ Move Layers | Groups
N Gizmo

/ B REPRE OFE - NAPTE o B-EiEe - & | 4
'J !j Q jil" :T*:' 5 ; figiv I‘.) £ had P %i _@] : 5 18 B 2D wireframe .7 .@ ; [EJ l—;l
ul

View
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Layers Setup
1. Inthe Menu Bar, sclect [Tools] 2> [Toolbars] > [AutoCAD] > [Layers].

Tools Draw  Dimension Modify  Window  Help  Parame 3D Navigation
Workspaces > Fe Output  Colla Array Edit
¢ Palettes % = fe . 1 Array_Toolbar
1l Toolbars - 2 A_“tO’CAD > CAD Standards
Command Line Ctrl+9 Section o ] Camera Adjustment
f Clean Screen Ctrl+0 Glane - Dimension
" %% Spelling ection ~ ¥ Co Dimensional Constraints
K& Quick Select.. Draw
Draw Order 3 Draw Order
Isolate 3 Draw Order, Annotation to Front
Inquiry 3 Find Text
lA:_wi‘ Update Fields Geometric Constraint
. Group
[ Block Editor Inquiry
Xref and Block In-place Editing > InSer
E‘g Data Extraction... Layers
Data Links > Lakrs M
ss?%.-,-?jlo . _ .
2. Click Layer Properties Manager in the
(=] Layer Properties Manager Layers toolbar.

% In AutoCAD, we always construct entities on a layer. It may be the default layer or a
layer that we create. Each layer has associated properties such as the visibility setting,
color, linetype, lineweight, and plot style.

":& == = 3. Click on the New Layer button. Notice a layer is
automatically added to the list of layers.

B New Layer (Alt+N)

4. Create two new layers with the following settings:

Layer Color Linetype Lineweight
Construction Grey Continuous  Default
Object Cyan Continuous 0.30mm

5. Highlight the layer Construction in the list of layers.

& & & || 6. Click on the Set Current icon to set layer Construction
:‘ S.. Name :&ﬂn_gm as the Current Layer.

= 0 | Set Current |

Search for layer O, ,% 7. Click on the Close button to accept the settings and exit

o the Layer Properties Manager dialog box.
(_‘," Close %
Plot St.. | N. Descriptio 8. In the Status Bar area, turn ON the Grid Display, Polar
Normal [l Tracking, Object Snap, Object Snap Tracking, Dynamic

Normal L Input and Lineweight options.
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Create the Rectangular Base of the Design

We will first use construction geometry to define the outer edges of the design.

“£54| 9 @ L] i W Construction

O,

WEA 1. Inthe Layer Control box,

i _ - :—_ ! la] D
- & o £ ol

2 0 L gf' M Object

W | construction

confirm that layer
Construction is set as the

Current Layer.

bols Draw Dimension I

rametric  Insert  Annotate
rD A T e & H
NSO ®C
IOl mIECRINCEY W]

N

Rectangle

r Drd

Creates a rectangular

Select the Rectangle icon in the Draw toolbar. In the
command prompt area, the message “Specify first corner
point or [Chamfer/Elevation/Fillet/ Thickness/ Width]:”
is displayed.

Place the first corner point of the rectangle near the
lower left corner of the screen. Do not be overly
concerned about the actual coordinates of the location;
the drawing space is as big as you can imagine.

4. We will create a 3” x 2" rectangle by entering the coordinates of the second corner
using the relative coordinates input method.
Specify other corner point or [Dimension]: @3,2 [ENTER].

TEE IEDWireframe - g
ta, |Unsa1.red"u"iew v_| c
- @Tap
H|[€|Buttnm |
i Left
(5 Right
"._jFrn:nnt
gBack

i3 SW Isometric
K‘% SE Isomgtric |

€ NEIsnrrJrESEI -
SOMELrC
€2 NW Isl:urr[

View Manager...

ele

In the View panel, select:
[Unsaved View] - [SE Isometric]

Notice the orientation of the sketched 2D rectangle in
relation to the displayed AutoCAD user coordinate
system. By default, the 2D sketch-plane is aligned to
the XY plane of the world coordinate system.
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Create a Wireframe Box

Next, we will use the Copy command to define the 3D boundary of the design.

mension  Modify  Window |+ 1. Click on the Copy Object icon in the Modify toolbar.
Annotate  View  Manage

o AP By | 2. Inthe command prompt area, the message “Select
. o objects:” is displayed. Pick any edge of the sketched
B @& C Copy rectangle.
S ABRl9q

Modify Copies 0BJectst 3 [ngide the graphics window, right-click once to accept

the selection.

4. In the command prompt area, the message “Specify base point or displacement, or
[Multiple]: is displayed. Pick any corner of the sketched rectangle as a base point to
create the copy.

5. In the command prompt area, the message “Specify second point of displacement or
<use first point as displacement>:” is displayed.
Enter @0,0,2.25 [ENTER].

» Note that the three values represent the distance measured in the X, Y and Z
directions relative to the current UCS.

e,

6. Use the Zoom All command, in the View Display toolbar, to
adjust the display.

o,

g
L

F
=

On your own, use the Line command to create the four lines
connecting the four-corners of the two rectangles as shown.

&

I

v | Zoom Extents

Zoom Window

Zoom Previous

Zoom Realtime

Zoom All I::?

=z ™

bls Draw Dimension Mod

Bmetric  Insert  Annotate V|
DE T B
I"\_'T /- {Ei} - Il'—_l [,@LJ 6

oW

Line

I ; ;
Creates straiaht line seat
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Using the View and UCS Toolbars

1.

In the Menu Bar, select [Tools] 2 [Toolbars] = [AutoCAD].

Tools Draw

Workspaces
Palettes
Toolbars

| Command Line
Clean Screen

Dimension

Modify  Window Param

>
L U N
> AutocAly >
Offset Cop

Help

Ctrl+9
Ctrl+0

Move

-

ucs

ucsii

View
Viewpo%s
Visual Styles
Walk and Flv

Text 3.
ucs

ucsi
View 4.
Viewpaorts

>

2. Select View, with the left-mouse-button, to display the View
toolbar on the screen.

Move the cursor to the Standard toolbar area and right-click
on any icon of the Standard toolbar to display a list of toolbar
menu groups.

Select UCS I, with the left-mouse-button, to display the
UCSII toolbar on the screen.

The options available in UCS II toolbar allow us to quickly align the UCS to the

preset standard 2D views.

i, 12|

1® world

w X

1® world

= Previous

Top
Bottom
Back
T Left

T Right

LRRERR

>

Note that the UCS has been
adjusted and it is now aligned
parallel to the front view of the
wireframe box as shown in the
figure.

5. Note that the current UCS is aligned to the
World Coordinate System. Select Front in
the UCS II toolbar as shown.
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Create Construction Lines in the Front View

Is Draw Dimension Mo
pmetric Insert  Annotate |
DA T AP

NRO- s ®C
[ fak

Line

= Temporary track point
—
h From
Mid @e‘rween 2 Points
Point Filters b

3D Osnap >

Restrict cursor to specified
Polar Tracking (F10)

b G Y - [~ 3

3, 1T, I3, £0.

Trackjr\q\Settings... N
L [G]- Y [£]E - |

A Drafting Settings

Snap and Grid Polar Tracking Objd

[«]Polar Tracking On {F10)
Paolar Angle Settings
Increment angle:
[30 v

g

1.

Select the Line command icon in the Draw toolbar. In
the command prompt area, the message “ line Specify
first point.” is displayed.

Inside the graphics window, hold down the [SHIFT]
key and right-click once to bring up the Object Snap
shortcut menu.

Select the From option in the pop-up window.

Pick the lower right corner of the bottom horizontal
line in the front view as the base point.

In the command prompt area, the message “Specify
next point or [Undo]:” is displayed. Enter @0,0.75
[ENTER].

We will set up the Polar Tracking option to assist the
creation of the next corner. Right-click once on the
POLAR Tracking option located at the bottom of the
graphics window.

In the option menu, select Settings by clicking once
with the left-mouse-button.

In the Drafting Settings dialog box, set the Polar
Increment Angle setting to 30 degrees.

A Drafting Settings

Snap and Grid Paolar Tracking Obje%Snap 30

[.1 Ohiect Snan On (F3)

9. Click on the Object Snap tab to switch to
the Object Snap option settings.
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A Drafting Settings

[¥] Object Snap On (F3)
Object Snap modes

1 [“]Endpoint
[IMidpaint

[~ Center

[] Geometric Center
[INode

[JQuadrant

X o’ ook

InLeL{)ection

Snap and Grid Polar Tracking ObjectSnap 3D ObjectSnap Dynamic In

> HMAF F

Object Snap Tracking

[~ Extension
[1insertion

[ Perpendicular
[ Tangent
[INearest

DApparentmtersectlon

CParallel

a Ta Snaps to the intersection of an object such as an a
3 line, polyline, ray, region, spline, or xline. Extended
not available a5 3 running obiect snan

13. Move the cursor near the left vertical
edge of the front view and create the
second line perpendicular to the last
line we created.

14. Inside the graphics window, right-
click to activate the option menu and
select Enter with the left-mouse-
button to end the Line command.

10. Confirm that the Intersection and

11. Click on the OK button to accept the

Extension options are switched ON as

shown.

settings.

o0

12. In the command prompt area, the
message “Specify next point or [Undo]:”

is displayed. Using the Polar Tracking
option (30 degrees increment), create a

line as shown in the figure.

Enter
Cance[l}

Recent Input

[<z07]

- \‘\\ \\“\
»\\\ . \\
. \\\“\ . \\\
O

\R“a\\‘ . -
N
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Copy Objects in the Negative Z Direction

mension  Modify  Window |1 Click on the Copy Object icon in the Modify toolbar.
Annotate  View  Manage

e & P Y- | 2. Inthe command prompt area, the message “Select
. . i — objects:” is displayed. Pick the two edges we just
B @ C Copy created.

£ Agl e Copies objects ) . . . .
Modify 3. Inside the graphics window, right-click once to accept
the selection.

4. In the command prompt area, the message “Specify base point or displacement, or
[Multiple]:” is displayed. Pick any corner of the wireframe model to use as a base
point to create the copy.

5. In the command prompt area, the message “Specify second point of displacement or
<use first point as displacement>:" is displayed.

Enter @0,0,-2.0 [ENTER].

6. Note that the negative value represents the distance measured in the negative Z
direction relative to the current UCS.

7. On your own, create three lines to connect the corners of the two sets of lines we just
created, as shown below.
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Create an Inclined Line at the Base of the Model

i, 12 | (P Top ~ X[ 1. Select Top in the UCS II toolbar as shown.
Is Draw  Dimension Mo . . .
- 2. Select the Line command icon in the Draw toolbar. In
e irsort. Diniad TN the command prompt area, the message “ line Specify
DA A P first point.” is displayed.
NAO - @ | .
T - 5 @G 3. Inside the graphics window, hold down the [SHIFT] key
WL e and right-click once to bring up the Object Snap
shortcut menu.
= Temporary track point
—
i Fr-::-m@e
M'_d _tween 2 Points 4. Select the From option in the pop-up window.
Point Filters b
3D Osnap >
_ | _ 7| 5. Pick the lower right corner of the bottom horizontal line
5 _ e as the base point as shown in the figure.
>E _ ' 6. We will place the first point above the selected corner.

Enter @0,0.75 [ENTER].

7. In the command prompt area, the message “Specify next
point or [Undo]:” is displayed. Using the Polar Tracking
option (30 degrees increment), create a line as shown in

the figure.
[-1ISE Isometric ]| 2D Wireframe] - \-\

8. Inside the graphics window, right- T R R
click to activate the option menu : A R NN
. . . P . e A
and select Enter with the left- . . N e . X

mouse-button to end the Line e AN

command. . T NTT
Enter : /-/ : A . -
. o~ . \: >
Cance% . T~ AN N
Recent Inout > < ' N N -

X . . ~1
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» On your own, use the Copy and Line commands to create additional edges so that the
wireframe model appears as shown below.

[-1ISE Isometric]|2D Wireframe] -/“““R

-

\‘M\x I 5\\‘ T
/"f’f ?“:: 7 / ‘-""’-.--"-' Y
_;__f__;/ﬁk‘t:;/.

: -~ A \\

_ f,f_
/ )
/N~

S~ -
z Y . . \H\ . . 'l._‘/ .
. . . \Kx _ . P
. . . RH"\\I___.—--—____ =
Create Object Lines
25| 9 © Ll g W construction 1. On the Object Properties toolbar, choose
(] Q i O the Layer Control box with the left-mouse-
(-IC e E} E3 u"' [l Construction button.
e lidMl
Object 2. Move the cursor over the name of layer
= Object; the tool tip “Object” appears.

3. Left-click once on the layer name; now layer Object is set as the Current Layer.

bls Draw Dimension Moaodq

bmetric Insert  Annotate
4. Select the Line command icon in the Draw toolbar. In

DA 7 e g
N = . | ,E; + the command prompt area, the message “ line Specify
NAO B &C first point:” 1s displayed.
G -
’ Line

r ; ;
Creates straiaht line seqi
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5. Pick the lower left corner of the bottom of the wireframe model as the starting point
and create the four line segments as shown.

[—1I5E Isometric J|2D Wireframe]

Fifth point N .

First point N ~

Second point |

Fourth point

. \.‘. .R“"-uc,_\_\

-
e ]

Note that even though the UCS is aligned to the base plane of the model, the Object

Snap option enables us to select points on the front plane of the model.

» On your own, create three additional lines representing the edges of the inclined face

of the design as shown.

[—lISE Isometnic ]| 2D Wareframe]
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Multiple Viewports

W T

Pan

8

v
a

I Orbit

Walk

% Hide

Aiciy

View Insert Format  Tools Draw
Pl " Redraw

Regen
E‘g Regen All

Zoom >

SteeringWheels
ShowMotion

Camera >

and Fly >

Clean Screen Ctrl+0

Viewports >
EE MNamed Views...

3D Views >
f@| Create Camera

Show Annoctative Objects >

LSl LY

Dimension Modify  Wind

sert

E)
=" -
I

-

; %

sy
==

—

Amotate View  Mand 1. In the Menu Bar, select:
e &P BN - . .
- [View] 2 [Viewports] >

B ®C L - )
J ARl &9 [4 Viewports]
Modify ~

» AutoCAD allows us to display
different VIEWS of the model
simultaneously. Only one
viewport is activated at one
time. The viewport with the
darker border is the active

Named Viewports... i
viewport. Move the cursor

New Viewports...

= inside each viewport and
1 Viewport R .
e notice the different cursor-
3 Viewports display inside the active
by viewport.

Polygonal Viewport

BRI B

Top

Sets the view point to top

=m VIEW

2. Activate the top left viewport by left-clicking once

inside the viewport.

3. Select the Top view in the View toolbar to change

the display of the viewport.

4. On your own, repeat the above steps and use the Realtime Zoom command to set
and adjust the displays of the viewports as shown below.

.I|+]|SE Isomeétric]|2D Wireframe] ;’/. S
-

L . S

\

» Note that the displayed UCS icons at the lower left corner of each viewport
correspond to the orientation of the wireframe model in each viewport.
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Use the Mirror Command
1. Activate the top left viewport by left-clicking once inside the viewport.

2. Pre-select all the objects in the active viewport by using a selection window.

[+1TopH2D Wireframe] -

First corner /

Y ‘ { Second corner

X
Subobject Selection Filt

Quick Select... 3. Inside the active viewport, right-click to bring up the pop-

Quick&w up option menu and select the Quick Select option.

m Lind

A Quick Select X

4. In the Quick Select dialog box, select
Applyto: | Curentselection | Layer from the Properties list.
Objecttype: |Mu|tjp|e v|
Properties: [Color 5. Set the Value box to Object
Linepe .
Linetype scale 6. Inthe How to apply section, confirm the
Plot style . . .
Lineweight Include in new selection set option
Transparency .
Hyperlink is selected.
7. Switch OFF the Append to current
selection set.
Operator: |=Equals v|
Value: |Object v 8. Click on the OK button to accept the

How to apply: s

© Include in new selection set

settings.

(O Exclude from new selection set

e AutoCAD will now filter out objects
[]Append to current selection set that are not on layer Ob]eCt

| OK | | Cancel | | Help
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Annotate  View Manage Output

e A B % - f@ 1 9. Click on the Mirror icon in the Modify toolbar.

B®C D o
| = AD e I;J;J . sz;:;” { 10. Inside the graphics window, hold down the [SHIFT]
- - key and right-click once to bring up the Object

Section v
Snap shortcut menu.
B8 9 8 4
E| B ] e o . . . .
b = D ror 11. Select the Midpoint option in the pop-up window.
= OB :
Y Creates a mirrored

A Modify D/j Endpoint

7 Midpgint
[+1Tepll2D Wireframe] >< Interséttion

\< Apparent Intersect

12. Inside the active viewport, click on the left vertical line
of the wireframe model. With the Midpoint snap option,
the midpoint of the line is selected.

13. Move the cursor toward the
right vertical line in the active
viewport; left-click once when
the Intersection symbol is
displayed as shown.

14. In the command prompt area, the
message “Delete Source Objects?
[Yes/No] <N>:"is displayed.
Inside the graphics window, right-
click once to bring up the option
menu and select No to keep both
sets of objects.

Yes
| No_ |
L
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Turn Off the Construction Lines

1.

On the Object Properties toolbar, choose the Layer Control box with the left-mouse-

button.

N

®% LMo

bject

@ Lynl' WO

onstruction

+m & C
jadeErl

Turn a layer On or Off turned OFF.
View Insert Format Tools Draw  Dimension  Modify
| " Redraw sert  Annotate  View
- C
| Regen LR
L. T3 Regen All Y-
lté [/ 1% ® 6 D—'_'-
7 > b ) .
oom 2R A E =
Pan ’ Modi
() steeringWheels f odify ~
@D ShowMotion
1 Orbit > B
; Camera >
Walk and Fly >
Clean Screen Ctrl+0 \

Viewports > EI%I Named Viewports...
= Naméd\flews... 1 New Viewports...
3D Views > 1 Vigwport
(@) Create Camera 2 Viewports

Show Annotative Objects > 3 Viewports

2. Move the cursor over the light-bulb icon for
layer Construction, left-click once, and notice the
icon color is changed to a gray tone color,
representing the layer (layer Construction) is

In the Menu Bar, select:

[View] = [Viewports] 2>
[1 Viewport]

Viewports can also be used as a
way of checking the integrity of
the constructed 3D models. Feel
free to switch to multiple
viewports in the following
sections of this tutorial.

On your own, create the
additional object lines
connecting the two sets of objects
as shown below.
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» The V-cut feature of the
design is the last feature, and
perhaps the most difficult one,
to create in the CAD system.
Based on your knowledge of
modeling with AutoCAD,
how would you create this
feature? What are the more
difficult aspects of creating
this feature?

Create a New UCS

Besides using the preset UCS planes, AutoCAD also allows us to change our viewpoint
and create new UCS planes. We will create a UCS plane aligning to the inclined plane of
the design.

Display Image > I I
el ~ 10 [ 1. Inthe Menu Bar, select:
ew L or
'3 Named UCS T': orevoss [Tools] = [New UCS] 2>
" ’ [3 Point].
& Geographic Location.. to  Face
CAD Standards > 18, Object e Note that other options are also
Wizards > 10 view available to aid in the creation
I, Drafting Settings.. ta, Origin of new UCS planes.
[El" Group 2, 7 Axis Vector
a
Ej‘ Ungroup TE. 3&’"“
Tablet > box

2. In the command prompt area, the message
“Specify New Origin point <0,0,0>:” is
displayed. Pick the lower-left corner of the
inclined plane as shown.

-

Intersection
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|

Intersection

4. In the command prompt area, the
message “Specify point on positive
portion of X-axis:” is displayed. Pick the
top left corner of the inclined plane as

In the command prompt area, the message
“Specify point on positive portion of X-axis:”
is displayed. Pick the lower right corner of
the inclined plane as shown.

shown.
>
Pk d
> UGS Icon > B on 5. Inthe Menu Bar, select
ViewCube > & Origin
Attribute Display > Pmpﬁrties_ [VIeW] > [Dlsplay] >
(] Cameras N [UCS Icon] = [Properties]
£ Lights
E| Navigation Bar
F=] Text Window Ctrl+F2 A UCS Icon
N
UCS icon style
6. Inthe UCS Icon window, switch the UCS icon style to @20
2D as shown. % .
O3 Line widt}

7. Click on the OK button to
accept the settings.
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Create a New Named View

Besides using the preset views, AutoCAD also allows us to change our viewpoint and
create new views, which can be saved and restored by name for convenient access. We
will create a new view aligned to the new UCS plane we just created.

1. Inthe Menu Bar, select
[View] - [3D Views] -2 [Plan View] - [Current UCS].

Viewpaorts >
= Named Views... /\
3D Views > 1% Viewpoint Presets...
(@] Create Camera Tﬁ Viewpoint
Show Annotative Objects > Plan View > [E Current UCS
_ =
@ Hide @ Top E Worla UCS
Visual Styles > (& Bottom = Named UGS
Render > D Left

e The graphics window is now adjusted to display the current UCS plane.

EEE%EQ A0 ¢ #| 2. Click on the Named Views

icon in the View toolbar.

X . . Named Views...

3. Inthe View dialog box, click on the New button to
create a new named view.

Set Current

e
Lz

Update Layers

A New View / Shot Properties

4. Inthe New View dialog box, enter

View name: |‘°‘“’“'”a'71 Auxiliary as the new View name and
confirm the Current display option. In
the View Properties list, set the Save
View type: still layer Snapshot with view option to
ON and the UCS option as Unnamed.

View category: |<:N|:|ne>

Boundary

(@) Current display
() pefine window

I 5. Click on the OK button to accept the
settings and create the named view.
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6. In the View dialog box, the new named view (Auxiliary) is added to the Named Views
list. Note that we can always switch to this view by using the Set Current option.

A View Manager X

Current View: Current

Views
o Q current General e Set Current
EEE gfizlx\;;::ws Name Auxiliary
Llfyout Viegs Category <MNonex>
&[] Preset Views ucs Unnamed Update Layers
Layer snapshot Yes Edit Boundaries...

Annotation s... 1:1
Visual Style 2D Wireframe Delete
Background... <MNone:=

Live Section <MNonex>

Animation 4
View type Sti

| OK || Cancel || Apply || Help

7. Click on the OK button to accept the settings.

| .
%‘@@@gg|@ gﬁ?@’l @||1‘Ir_;|_[ 8. 1In the View toolbar, select SE

Isometric View.

SE Isometric
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Create the V-Cut Feature on the Inclined Plane

1. On your own, create two lines that are 0.2"” away from the top corners of the model,
which are also rotated 45 degrees relative to the top edge of the model.

6. Second Point

"

a

5. Base Point

mension  Modify  Window

Annotate  View  Manage

nEE Y g

& ®C F=
£ ARl Copies objects
Modify

Click on the Copy Object icon in the Modify toolbar.

In the command prompt area, the message “Select
objects:” is displayed. Pick the two inclined lines we
just created.

Inside the graphics window, right-click once to accept
the selections.

5. In the command prompt area, the message “Specify base point or displacement, or
[Multiple]: is displayed. Pick the top left corner as the base point to create the

copy.

6. In the command prompt area, the message
“Specify second point of displacement or
<use first point as displacement>:" is
displayed. Pick the corresponding corner
on the backside of the model as shown in
the above figure.

7. On your own, create addition lines to
define the edges of the V-cut and use the
Trim command to complete the model as
shown.
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BODEAHD S

Front

8.

Click on the Front View icon in the View
toolbar.

hd

» Note that the V-cut we
created, using the Copy
command, does not represent
a cut that passes through the
entire block.

.

Extend the Cut and GRIP Editing

mension  Maodify  Window  Help
Annotate  View Manage QOutpy

nEeBEE o

& ®C 0 i

ol A B = e
Modify + _—" end w

Extend

1.

Select the Extend command icon in the Modify
toolbar.

2. The message “Select object to Extend or [Project/ Edge/ Undo]:” is displayed in the
command prompt area. Pick the bottom edge of the V-cut to extend.

Boundary
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3. Inside the graphics window, right-click to activate the option menu and select Enter
with the left-mouse-button to end the Extend command.

BOIHIRBRS S O|s

SW Isometric

4. Click on the SW Isometric View
icon to reset the display to the preset
isometric view.

5. Pre-select the top edge of the V-block as shown.

6. Left-click once on the lower right grip point on the
selected line.

e Selecting the grip points located at the end of the line or
arc allows us to STRETCH the selected line.

7. Move the cursor toward and select the lower corner of
the V-cut as shown.

» On your own, repeat the above steps and use the grip

_ editing options and complete the wireframe model as
Endpoint
shown below.

<77\

\




UCS, Viewports and Wireframe Modeling ~ 3-25

Review Questions:

1. List and describe three different types of 3D computer geometric modeling software
available today.

2. What is a Named View?

3. What is the difference between Stretch and Extend?

4. List and describe the methods available in AutoCAD to create a new UCS plane.
5. What is the difference between Copy and Mirror in AutoCAD?

6. Identify and describe the following commands:

a)

T
b)
c)

—f
d)

Al




3-26

AutoCAD 2021 Tutorial: 3D Modeling

Exercises: (Unless otherwise specified, dimensions are in inches.)

1.

473

6,50
~—130 3.50
100 — 100
4,00
1.00—
173
273
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